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OO VV EE RR VV II EE WW   
This course is designed to instruct the participants on how to navigate within the 
SCT Banner Human Resources system.   

Topics include: 

 The Main Menu 

• Discussions on Main Menu, QuickFlow, and Personal Menu 

 Menu Bar 

• File, Options, Edit, Block, Field, Record, Query, Help, and 
Window Menus 

 Toolbar 

 Forms 

• What are forms? 

• Types of forms 

• Components of forms 

• Dialog and alert boxes 

• Object search 

• Navigating a form 

 Help  

• Online Help 

• Dynamic Help 

• SCT Banner Bookshelf 

• Show Keys 

• Help (Item Properties) 

• Auto Hint 
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1 . 1  D I S C U S S I O N  

In this Section, you will learn how to: 

 Describe the parts of the SCT Banner Main Menu 

 Navigate around the Main Menu 

 Select and access forms 

 Create your Personal Menu 

 Create and run a Quickflow Process 

M A I N  M E N U  D I S C U S S I O N  

Before performing any job functions on the SCT Banner HR system, participants 
must first learn how to access and use the Main Menu.   

                                    Direct Access                      

Menu Bar                                                                                                        Horizontal Toolbar 

 

 

                           Auto hint/Status Line             
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   SCT Banner Main Menu 

   Menu Bar 

• Offers a variety of selections for navigating within SCT Banner 

   Direct Access 

• Allows direct access to forms, jobs, menus, and Quickflows by name 

• Can be used from a menu or form 

   Horizontal Toolbar 

• Set of icons that represent shortcuts for performing common functions 

   Main Pane 

• Shows the various levels of menus at your organization 

• Can be reorganized to meet specific needs of your organization 

• Currently selected menu is highlighted in blue 

• Graphic folders show whether the menus are open or closed 

   Auto Hint/Status Line 

• Briefly describes the field where the cursor is located 

• Explains the purpose of the field, what can be done next, or how to move 
to another window or form 

• Error messages and processing messages appear here 

 

The Main Menu provides an overview of the menus, forms, jobs, and 
QuickFlows in SCT Banner.  You can use the Main Menu to navigate through 
SCT Banner. 

Menus are arranged in a hierarchy.  When a closed folder  precedes a menu 
item, you can expand the item to show its entries.  When an open folder  
precedes a menu item, the item has already been expanded; you can collapse it to 
remove its entries.  In SCT Banner, you can expand or collapse a menu by 
clicking the folder.   

The Main Menu has a familiar Windows format: 

o Product Menus organize menus, forms, jobs, and QuickFlows by 
office.  (Examples: “Finance” and “Human Resources”). 

o Personal Menus include the forms, jobs, menus, and QuickFlows 
that are most important in your daily work. 
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Q U I C K F L O W  D I S C U S S I O N  

A QuickFlow is a technique that lets you access a set of forms in a specific 
sequence that enable a task to be accomplished both efficiently and completely.  
QuickFlow enables you to customize your job tasks by identifying those forms 
that are required to perform that task and processing them in the appropriate 
sequence. 

For example, if one of your responsibilities includes entering new employees into 
the system, you could define a QuickFlow that accesses all of the forms required 
for that task without going through each required form on the menu. 

 

P E R S O N A L  M E N U  D I S C U S S I O N  

A personal menu includes the forms, jobs, menus, and QuickFlows that are most 
important in your daily work.  You can access your personal menu from the main 
menu.  It is tied to your Oracle user ID. 

The Personal Menu Maintenance Form (GUAPMNU) allows you to create and 
change your personal menu. 

The Personal Menu Maintenance and Copy Form (GUTPMNU) allows you to 
copy your personal menu to or from another user. 

1 . 2  E X E R C I S E S  

1 . 2 . 1  M A I N  M E N U  A N D  D I R E C T  A C C E S S  E X E R C I S E   

ACTIONS 

1.   Double click the Banner folder 

2.   Select the Human Resources System Menu folder  

3.   Within the Human Resources System Menu folder, select 
Biographic/Demographic Information Menu. 

4.   Select the Identification Form (PPAIDEN).  The Identification Form will 
appear on the screen. 

5.   Select the Exit function  in the upper right corner of the Toolbar. 

6.   You’ve now returned to the SCT Banner Main Menu. 

7.   To access the Identification Form without going through the menu system, 

select the Direct Access field  and enter the seven-
character code assigned to that form, (PPAIDEN). 

8.   Press [Enter] (or [Return]) on your keyboard.  The Identification Form will 
appear on your screen. 



SCT Banner Human Resources 5.0 
7 

9.   Select the Exit function to return to the Main Menu. 

 

1 . 2 . 2  Q U I C K F L O W  E X E R C I S E  

ACTION 

To define a QuickFlow: 

1.   Determine the purpose of your QuickFlow, and identify all forms that must 
be accessed for the task you wish to perform.  Let’s use the following 
example: 

Purpose:  Add skills and experience to an employee record 

Forms needed:  PPAIDEN, PPAEXPR, PPASKIL 

2.   From the Main Menu, enter the QuickFlow Validation Form (GTVQUIK) in 
the Direct Access field. 

3.   Select the Insert Record function . 

4.   Enter a code in the QuickFlow Code field and a description in the 
Description field (EEXP, Employee Experience). 

5.   Select the Save function (either in the pull down menus or ). 

6.   Select the Exit function. 

7.   From the Main Menu, enter the QuickFlow Definition Form (GUAQUIK) in 
the Direct Access field. 

8.   In the QuickFlow field, enter the QuickFlow code just created (EEXP). 

9.   Select the Next Block function .  All existing names appear in the left 
pane. 

  

 You can use the Find feature to locate your files.  Simply enter the 
letter or letters in the Find field.  For our example, enter XP. 

  

10.   Click the three object names defined in Step 1.  Drag and drop them from 
the left pane to the right pane.   

  

 Be sure to list the object names in the order they are to be accessed 
in the QuickFlow. 

  

11.   When all the desired objects are entered in the right pane, select the Save 
function. 

12.   Select the Exit function to return to the Main Menu. 
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To run a QuickFlow: 

1. From the Menu Bar, select File>QuickFlow or use Direct Access to display 
the QuickFlow Form (GUAQFLW). 

 
 

  

2.    Select Search  to find and double-click the code. 
  

 You can enter the QuickFlow code in the QuickFlow field to begin 
the QuickFlow process. 

  

The QuickFlow code and its description will be displayed. 

3. Select the Start button to execute the QuickFlow function. 

4. Select the Exit function through the three forms. 

5. Select the Cancel option to return to the Main Menu. 

1 . 2 . 3  P E R S O N A L  M E N U  E X E R C I S E  

ACTIONS 

To use the object list to add an object to a personal menu: 

1. From the Main Menu, enter the Personal Menu Maintenance Form 
(GUAPMNU) in the Direct Access field. 

2. Use the pull-down list above the left pane to select the object type you want 
to display.  The left pane lists the objects of the selected type that can be 
added to the menu. 

  

 If you know the object’s seven-character name, you can enter it in 
the blank Name field in the right pane and press Enter. 

  

3. In the left pane, select each object you want to add to the menu.  When you 
select an object, the name is highlighted. 

4. If you need to add more object types, repeat steps 2 and 3. 
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 You can select objects from multiple object types and insert them 
together. 

  

5. Click an area in the right pane where you want to place the new menu items. 

6. Select the Insert Selection option .  The selected objects are added to the 
right pane below the place you selected. 

7. As an option, you can customize the object description. 

8. Select the Save function. 

9. Select the Exit function to return to the Main Menu. 

 

 
 

To query objects and add to a personal menu: 

1. From the Main Menu, enter the Personal Menu Maintenance Form 
(GUAPMNU) in the Direct Access field. 

2. Use the pull-down list above the left pane to select the object type you want 
to query. 

3. Place the cursor in the left pane and select the Enter Query button .  The 
object list disappears. 

4. Enter the search criteria.  For our example, we’ll use P%. 
  

 You can use the Oracle wildcards % and _.  Capitalization matters!  
Data is matched against the search criteria exactly as you enter them. 

  

5. Select the Execute Query function .  The left pane lists the matching 
objects. 
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6. In the left pane, select each object you want to add to the menu.  When you 
select an object, the name is highlighted. 

7. Click an area in the right pane where you want to place the new menu items. 

8. To add all matches to the menu (if there are 20 or less), select the Insert All 

option .  To add selected matches to the menu, select the Insert Selection 
function. 

  

 If you need to delete objects from the personal menu, select the 
object in the right pane and press the Remove Selection option.  If 
you need to delete ALL objects from the personal menu, select the 
Remove All option.  

  

9.  Select the Save function. 

10.  Select the Exit function to return to the Main Menu. 

To copy a personal menu: 

1. From the Main Main, enter the Personal Menu Maintenance and Copy Form 
(GUTPMNU) in the Direct Access field. 

2. Use the pull-down list above the left pane to select the user who’s personal 
menu you want to copy.  The selected personal menu appears in the right 
pane. 

  

 You may add, change, or delete from the menu before it is copied.  If 
you want to change the original menu, select the Save function.  If 
you want the changes to affect the copies only, do NOT select the 
Save function.  

  

3. Select the display users option .  A list of user IDs appears in the left 
pane. 

  

 To reduce the list of IDs, enter a partial ID in the field above the left 
pane.  Start with the first character and enter as many characters as 
you know.  Press Enter. 

  

4. Select each User ID to receive the copied menu.  When an ID is selected, it is 
highlighted. 

5. Select the Copy to User option . 

6. If any of the Users already have a personal menu, a dialog box will ask if you 
want to override existing personal menus.   

• Select the Yes option to overwrite all selected personal menus. 

• Select the No option to review each User ID.  A dialog box appears 
for each ID that already has a personal menu.  Select the Yes option 
to overwrite the old menu, or Select the No option to keep the old 
menu for that User ID. 
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7. When the menus are copied, a message tells you how many menus were 
copied successfully. 

8. Select the Save function. 

9. Select the Exit function to return to the Main Menu.  
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SS EE CC TT II OO NN   22 ::     MM EE NN UU   BB AA RR   

2 . 1    D I S C U S S I O N  

In this Section, you will learn how to: 

 Describe the SCT Banner Menu Bar 

 Access the pull-down menus 

 Use the pull-down menu items to navigate within a form 

The SCT Banner Menu Bar, located at the top of every form, contains pull-down 
menus. 

 
  

 If a pull-down menu is dimmed, the menu is disabled and cannot be 
accessed. 

  

You can access an option in a pull-down menu at any time, except when you are 
in a dialog box, alert box, or List of Values (LOVs).  You must respond to these 
windows before you can access a pull-down menu. 

The menu bar consists of several pull-down menus, each of which offer a variety 
of selections: 

F I L E  M E N U  

This pull-down menu contains standard SCT Banner and Oracle functions.  It 
also displays the last ten forms a user has accessed. 

Direct Access Displays the Direct Access Form (GUAPARM), which 
is used to access a form by its seven-character name. 

Object Search Displays the Object Search Form (GUIOBJS), which is 
used to search for a menu, form, job, or QuickFlow with 
part of the name, description, or type. 

QuickFlow Displays the QuickFlow Form (GUAQFLW), which is 
used to access a QuickFlow. 

Select Returns you to the calling form and enters the selected 
value into the field that called the form. 

Rollback Action depends on what type of form is currently used.  
For Application and Inquiry forms: clears all 
information (except Key information) and returns you to 
the first enterable field in the Key block.  For Validation 
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forms: returns you to the first enterable field on the 
form.  For Query forms: returns you to the first enterable 
field on the calling form. 

Save Saves all changes entered since the last time you saved. 

Refresh Clears the message line, redraws the screen. 

Print Prints the current window; inputs the date and time in 
the title bar. 

Exit From a form, exits you from the form.  From the Main 
Menu, exits you from SCT Banner.  From Query mode, 
cancels the query. 

Exit QuickFlow Exits you from QuickFlow. 

Preferences Displays the Personal Preferences Maintenance Form 
(GUAUPRF), which is used to customize SCT Banner 
for individual users. 

 

O P T I O N S  M E N U  

The Options pull-down menu contains the same navigation options that appear in 
the Navigation frame.  These options vary from form to form.  Some options take 
you to other blocks and windows within the current form.  Other options take you 
outside the current form. 

 

E D I T  M E N U  

The Edit pull-down menu contains the functions used to edit text items, such as 
descriptions.    

    

Cut   Cuts selected text and places it on the clipboard. 

Copy  Copies selected text and places it on the clipboard. 

Paste  Pastes text from the clipboard to the cursor location. 

Edit Displays the Editor window, which is used to enter and 
update text. 

B L O C K  M E N U  

The Block pull-down menu enables you to move from one block area to another 
within a form.  

    



SCT Banner Human Resources 5.0 
14 

Previous Moves the cursor to the next block that has at least one 
enterable field. 

Next Moves the cursor to the next block that has at least one 
enterable field. 

Clear Clears all information from the current block. 

 I T E M  M E N U  

The Item pull-down menu enables you to move from one field to another within a 
form.   

    

Previous  Moves the cursor to the previous enterable field. 

Next  Moves the cursor to the next enterable field. 

Clear Clears all information from the current field on your 
display.  Does not remove information from any records 
or tables. 

Duplicate Duplicates the contents of the same field in the previous 
record and copies it into the new record.  Used in a blank 
row of a repeating record. 

R E C O R D  M E N U  

The Record pull-down menu lets you work with records within a form. 

 

Previous Moves the cursor to the first enterable field in the 
previous record. 

Next Moves the cursor to the first enterable field in the next 
record of the current block.  If the cursor is in the last 
record, a new record is created. 

Scroll Up Scrolls up the list of repeating records, putting the first 
displayed record at the bottom of the list. 

Scroll Down Scrolls down the list of repeating records, putting the last 
displayed record at the top of the list. 

Clear Clears all information from the display of the current 
record. 

Remove Removes all information for the current record.  When 
you Save, the record is permanently deleted. 

Insert Inserts a new blank record in the existing records. 

Duplicate Duplicates the contents of all fields in a record and 
copies them into a new record. 
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Lock Temporarily locks the contents of the record so no other 
SCT Banner user can update it.  Save, Rollback, and 
Exit release the lock. 

      

 Q U E R Y  M E N U  

The Query pull-down menu contains the functions used to search for information 
in the database based on specific criteria. 

    

Enter Puts the form into Query mode so you can enter search 
criteria to see information already in the database. 

Execute Searches the database and displays records that match 
your search criteria. 

Last Criteria Enters the criteria from your last search (enabled only 
when you are in Query mode). 

Cancel Cancels the query and takes the form out of Query 
mode. 

Count Hits Counts the number of records that match the search 
criteria and displays that number on the Auto hint line. 

Fetch Next Set If more records meet the search criteria that fit in the 
window, clicking this option replaces the current set of 
displayed records with the next set. 

 T O O L S  M E N U  

The Tools pull-down menu contains functions related to other solutions 
integrated with Banner HR.  At USNH this includes the Banner Document 
Management System and Banner Workflow.  

    

Banner Document Management Suite  

  Gives access on the options to open or add documents 
that are related to the current form and employee you are 
viewing 

Workflow  

  Allows users to submit and release workflow requests.  
Not used a this time. 
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H E L P  M E N U  

The Help pull-down menu contains various help tools, the image displayer, a 
calculator, and a calendar. 

    

    

Online Help Displays online information for the current field.  This 
option may be disabled if Online Help is not available 
for the form. 

Dynamic Help Query 

  Displays the Dynamic Help Form (GUAHELP) in Query 
mode, which is used to display traditional help for a 
field, block, or form. 

Dynamic Help Edit 

  Displays the Dynamic Help Query Form (GUAHELP) in 
Edit mode, which is used to edit traditional help for a 
field, block, or form. 

Help (Item Properties) 

  Displays the Oracle item properties window for the 
current field.  The window lists properties such as 
internal database name, type of data, maximum length, 
etc. 

Show Keys Displays the list of functions and their equivalent 
keystrokes available in your environment for the current 
form, window, or field. 

List Displays the List of Values (LOV) for the current field if 
List of Values appears in the Status line. 

Display Error Displays the code that is in error, if an Oracle error 
occurs. 

Display ID Image Displays the image associated with the ID, if available, 
when the cursor is in an ID field. 

Calendar Displays the calendar. 

Calculator Displays the calculator. 

Extract Data Key Extracts Banner data (for the current block), along with 
Key data, for use in a spreadsheet.  This is available only 
from certain forms. 

Extract Data No Key 
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  Extracts Banner data (for the current block), without Key 
data, for use in a spreadsheet.  This is available only 
from certain forms. 

About Banner 

  Displays the About Banner Form (GUAABOT), which 
identifies the current form, release number, date, and 
time. 

  

SS EE CC TT II OO NN   33 ::     TT OO OO LL BB AA RR SS   

3 . 1  D I S C U S S I O N  

In this Section, you will learn how to: 

 Describe the SCT Banner toolbars 

 Describe the iconic buttons 

Toolbars are sets of iconic buttons that represent shortcuts for performing 
common functions.  SCT Banner has two toolbars: 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

    

 

 
                    Horizontal Toolbar 
             The horizontal toolbar appears directly under the menu bar. 
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Toolbars are one of the easiest ways to navigate through SCT Banner.  When you 
move your cursor to an iconic button, a yellow box, or bubble, appears.  Text in 
the bubble describes the function of the button. 

Many of the buttons found on the toolbars represent shortcuts for common SCT 
functions found on the Menu bar.  For example, you can use the SAVE icon to 
save changes. 

Toolbars are easy to use.  Simply click on the icon and it will perform the 
function. 
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SS EE CC TT II OO NN   44 ::     FF OO RR MM SS   

4 . 1  D I S C U S S I O N  

In this Section, you will learn how to: 

 Describe the different areas on the form 

 Enter Key Information 

 Describe fields, blocks, and records 

 Enter information from a List of Values (LOVs) 

 Save your changes 

W H A T  A R E  F O R M S ?  

An SCT Banner form is an online document where you can enter and look up 
information in your database.  A form visually organizes information so it is 
easier to enter and read.  An SCT Banner form is similar to a paper form, except 
information is entered once and then used by other forms, reports, and jobs. 

                                   Radio Buttons              Title Bar                                              

                                                                       Key  Info Block                 

 

Auto/Hint Status Line                                   Field                                                  Pull-downList 

                              Information Block                                             Checkboxes    
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                                      SCT Banner Form 

   Option Menu 

• Options that take you to other blocks within the current form or to related 
forms 

   Radio Buttons 

• Used to select one of several options 

• Each represents a choice; only one radio button can be selected 

   Title Bar 

• Displays the form’s descriptive name, the seven-character ID, the 
software version number, and the database name 

   Key Block 

• Contains information that determines what is entered or displayed on the 
remainder of the form 

   Iconic Buttons 

• Represent one or more actions that can be performed for the associated 
field or record 

   Auto Hint/Status Line 

• Briefly describes the field where the cursor is located 

• Explains the purpose of the field, what can be done next, or how to move 
to another window or form 

• Error messages and processing messages appear here 

   Information Blocks 

• Display data about the information entered in the Key Block 

• Area where you enter information prior to updating a record 

   Pull-down List 

• Used to select a field value from a list of pre-defined values   

• A down arrow in the right side of the field indicates the field has a pull-
down list  

   Checkboxes 

• Used to enable or disable features or options 

   Fields 

• Areas on a form where you can enter, query, change, and display specific 
information 



SCT Banner Human Resources 5.0 
21 

 

T Y P E S  O F  F O R M S  

Forms are identified by a seven-character naming convention used to describe the 
form, report, job, or table.  For example, PPASKIL is the form name used to 
identify the Person Skills Form.  The first character indicates the primary Banner 
System (S-Student, P-Human Resources, A-Alumni), the second character 
identifies the module (J-Job Submission, L-Letter Generation), the third character 
identifies the form type as described below, and the last four characters are a 
unique identification of the form.  A Naming Convention table can be found in 
Appendix A.  A sample of each form can be found in Appendix B. 

There are several types of forms: 

APPLICATION FORMS 

Application forms provide either data entry or query capabilities in SCT Banner.  
As data entry forms, they enable you to build information into the system.  As 
query forms, they allow you to request and view existing information (i.e. 
information already in a database).  This is the most common type of form. 

  

  “A” is usually the third character of an application form’s seven-
character name. 

  

INQUIRY FORMS 

Inquiry forms are used to look up existing information, often returning 
information to the calling form.  You can access an inquiry form from the main 
menu, from another form, with Direct Access, or with Object Search. 

  

 You cannot use an inquiry form to edit information. 

 “I” is usually the third character of an inquiry form’s seven-character 
name. 

  

RULE FORMS 

Rule forms are used to set up user-defined rules for calculations and parameters 
used to process data.  These forms enable you to tailor SCT Banner to your 
institution by defining your processing rules, if you have an appropriate level of 
security clearance.  Only a few users should have access to maintain rule forms. 

  

 “R” is usually the third character of a rule form’s seven-character 
name. 

  

VALIDATION FORMS 

Validation forms are used to define the values that can be entered in specific 
fields of an application.  Validation forms are defined when your system is 
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installed and can be added to or altered with discretion.  The values entered in a 
validation form make up a field’s List of Values. 

  

 “V” is usually the third character of a validation form’s seven-
character name. 

  

QUERY FORMS 

Query forms are used to look up existing information, often returning 
information to the calling form.  You must access these forms from another form. 

  

 You cannot access Query forms directly from the main menu, with 
Direct Access, or with Object Search. 

  

CONTROL FORMS 

Control forms are used to define the processing rules for application and 
validation forms at the system level.  You can enter new controls or revise 
existing ones if your security level permits. 

WIZARD FORMS 

Wizard forms are used to give step-by-step instructions for completing an 
application. 

C O M P O N E N T S  O F  F O R M S  

All SCT Banner forms are made up of three components: Blocks, Fields, and 
Records. 

BLOCKS 

Blocks are chunks of information grouped together.  A block may take up the 
entire information area in SCT Banner or there may be two blocks on the same 
screen, separated by a line. 

You can think of blocks as sections of a form.  For example, an employee’s 
record would have name information, address information, other personal 
information, and emergency contact information. 

There are two types of blocks within a form: 

Key Information Block 

The Key Information block is where a unique code is entered, such as an ID 
Number, term code, or document number.  This code lets SCT Banner know 
what piece of information you want to work on or view.  All information on this 
form refers to this key code.   

  

 Every SCT banner form has a Key Information Block. 
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Information Block 

An information block is a section of a form that contains related information.  A 
line separates each information block on a form creating the appearance of a 
block of related data. 

  

 Every SCT Banner form has at least one information block. 

  

FIELDS 

A field is a labeled space within a block where you can enter, query, change, 
and/or display specific information.  There is usually more than one field in a 
block. 

There are different types of fields within an SCT Banner form.  You may not be 
able to navigate to all fields within a form, and on query-only forms, you 
frequently cannot move through the fields at all.   

The different types of fields in SCT Banner are: 

• Enabled – Cursor is allowed in the field.  Information in the field is 
displayed in black text. 

• Disabled – Cursor is not allowed in the field.  Information, if it exists, is 
displayed in gray text. 

• Enterable – Usually enabled and information can be entered.  In certain 
situations, these fields may be disabled. 

• Display Only – Information cannot be entered in the field. 

Data entered or displayed in a field is a value.  Values are either free-format or 
come from a list on a validation form.  Examples of free-format values are names 
and street addresses.  Examples of fixed values are state codes (FL, PA, DE). 

  

 A fixed value must be entered exactly as it appears on the validation 
form.  You can generally display the validation form for a field (if 
one is available) by double-clicking within the field. 

  

RECORDS 

A record is a group of fields that make up a logical unit – a piece of information.  
An address, for example, is made up of several fields: street address, city, state, 
and Zip code.  A person may have multiple address records.  Some records are 
displayed as lists; for example, a class roster is a multi-record list with name, ID 
number, registration status, and other fields as the components of the record. 

  

 There may be more than one record in a block. 

  

SCT Banner has a record counter located on the Auto Hint/Status line.  This area 
of the status line displays the number of records viewed and the number of 
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records in total.  Some SCT Banner forms also have a scroll bar that you can use 
to view existing records.   

  

 If you see a question mark in the Status line, it means there are more 
records, but you haven’t gotten to the last one, so the computer 
doesn’t know how many there are yet. 

  

  D I A L O G  A N D  A L E R T  B O X E S  

DIALOG BOXES  

A dialog box is a window that appears when you must choose from two or more 
responses. 

 
You must acknowledge a dialog box before you can do anything else on the 
form.  The location of the cursor after you close the box depends on the dialog 
box and your response to the dialog box. 

ALERT BOXES 

An alert box is a window that notifies you of a condition that may impact data.   

You must acknowledge an alert box before you can do anything else on the form.  
The location of the cursor after you close the box depends on the alert box. 

  O B J E C T  S E A R C H  

You can use Object Search to access a form, job, or QuickFlow if you know part 
of its name, description, or type. 

  

 When you use Object Search from a form, the current form remains 
open.  When you exit the requested object, you return to the original 
form. 
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N A V I G A T I N G  A  F O R M  

NAVIGATING BLOCKS 

To navigate through Blocks, use the Next Block function  or the Previous 
Block function  located on the Toolbar.   

You can also use Ctrl + Page Down to navigate to the Next Block or Ctrl + Page 
Up to navigate to the Previous Block. 

  
  

 The Next Block function is probably the most commonly used 
function in SCT Banner. 

  

NAVIGATING FIELDS 

Just like Blocks, there are Next and Previous commands for fields.  The Next 
Field command is the [Tab] or [Enter] key.  The Previous Field command is 
[Shift-Tab].   

NAVIGATING RECORDS 

To navigate through Records, or to create new Records, use the Next Record 

function  or the Previous Record function  located on the horizontal Toolbar.  
You can also use the [Down-Arrow] and [Up-Arrow] keys to perform the Next 
Record and Previous Record functions respectively. 

To perform a search on a record, select the Search function . 

You can use the Oracle wildcards % and _ in the search criteria.  The percent 
sign (%) represents any number of characters, whereas the underscore (_) 
represents one occurrence of a character. 

To get these results:    Enter this criteria: 

All entries that contain ma   %ma% 

All entries that begin with ma   ma% 

All entries that end with ma   %ma 

All entries that have m as second character _m%  
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5 . 1  D I S C U S S I O N  

In this Section, you will learn how to: 

 Describe and access the following forms of Help in SCT Banner: 

• Online Help 

• Dynamic Help 

• SCT Banner Bookshelf 

• Show Keys 

• Help (Item Properties) 

• Auto Hint/Status 

SCT Banner offers a variety of Help options that can give you immediate 
assistance: 

ONLINE HELP 

The Online Help system provides online information for SCT Banner forms, 
windows, blocks, and fields.  Online help is currently available for selected forms 
only.  If available, the Online Help option is enabled in the Help pull-down 
menu.  You can easily access help for the field where the cursor is currently 
located.  You can then navigate to Online Help for the current form or to Online 
Help for another form in the same product.  Online Help is gradually replacing 
SCT Banner Dynamic Help. You must disable your pop-up blocker for this to 
work! 

Most end-user manuals feature a section on accessing online help in Chapter 2, 
Using SCT Banner. 

You can access Online Help from your Toolbar  or from the Menu Bar. 
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Online Help offers several levels of help including information about the form as a whole, valid 
entries, and individual fields. 

 

 

 

 

DYNAMIC HELP  

 

Dynamic Help is the traditional help for SCT 
Banner forms, blocks, and fields.  SCT Banner 
Dynamic Help is gradually being replaced by 
Online Help.  SCT Banner provides two kinds of 
Dynamic Help: 

 SCT Banner Dynamic Help – provided by 
SCT and is updated with each system 
upgraded.  You can change this help text, but 
each upgrade overwrites your changes. 

 Local Dynamic Help – written and maintained by your organization.  
System upgrades to not affect this help text. 

Dynamic Help is displayed on the Help Form (GUAHELP).  GUAHELP allows 
you to identify the help text you want to access.  You can access GUAHELP in 
Query mode or in Edit mode. 
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SCT BANNER BOOKSHELF 

SCT Banner Bookshelf provides access to user manuals, release guides, and 
other available system documentation directly from your computer.  These 
electronic documents appear in PDF (portable document format).  They are the 
same as the hard copy versions and can be printed. 

To access the Bookshelf, go to http://www.usnhgateway.org/ and select the 
documentation pull down menu. Then select the version of Banner that you are 
using. 

 

 
The following documents can be accessed using the SCT Banner Bookshelf: 

 

 User Manuals 

http://www.usnhgateway.org/
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 Technical Reference Manual (TRM) 

 Object: Access Reporting Data Models 

 Release Guides 

 Upgrade Guides 

 Implementation          
 Guides 

If you know where the information is located, you can go directly to a 
manual or chapter.  If you don’t know where information is located, you can 
search in one or more documents.  Your organization must set up SCT 
Banner Bookshelf before you can use it. 

 

 

 

 

 

 

 

 

SHOW KEYS 

Show Keys provides a list that shows the Oracle functions and associated 
keystrokes available for the current field, window, and form. 

HELP (ITEM PROPERTIES)  

Help (Item Properties) provides a list of all the properties of the field.  

AUTO HINT/STATUS LINE 

This hint at the bottom of the form briefly describes the field where the cursor is 
located.  Error and processing messages and keyboard equivalents also appear 
here. 
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N A M I N G  C O N V E N T I O N S  

SCT Banner forms, reports, jobs, and tables have seven-character names with the 
following structure: 

Position 1 identifies the primary system owning the form, report, job, or table. 

A   Alumni/Development L   Occupational Tax/License U   Utilities 

B   Property Tax N   Position Control V   Voice Response 

C   Courts O   Customer Contact X   Records Indexing 

D   Cash Drawer P   HR/Payroll/Personnel W,Y,Z  Reserved for client * 

F   Finance Q   Electronic Work Queue  

G   General R   Financial Aid  

I    Information Access S   Student  

K   Work Management  T   Accounts Receivable  

*  Reserved for client applications that co-exist with SCT Banner. 

 

Position 2 identifies the module owning the form, report, job, or table. 

HR/Payroll/Personnel (P) 

Position Control (N) 

A   Application 

B   Budget 

C   COBRA 

D   Benefit/Deductions 

E   Employee 

H   Time Reporting/History 

O   Overall 

P   General Person 

R   Electronic Approvals 
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S   Security 

T   Validation/rule table 

U   Utility 

X   Tax Administration 

 

 

 

Position 3 identifies the type of form, report, job, or table. 

HR/Payroll/Personnel (P) 

Position Control (N) 

A   Application form 

B   Base table 

     Batch COBOL process 

I   Inquiry form 

P   Process 

R   Rule table 

      Repeating table 

     Report 

V   Validation form/table 

Position 4, 5, 6, and 7 uniquely identify the form, report, job, or table. 

Example: 

PPAIDEN       

P  HR/Payroll/Personnel  

P General Person 

A Application   

IDEN Identification    
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S E C T I O N  4 :   F O R M S  

 T Y P E S  O F  F O R M S  

 

MAIN MENU 
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EXAMPLE OF APPLICATION FORM 
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EXAMPLE OF INQUIRY FORM 
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EXAMPLE OF QUERY FORM 
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EXAMPLE OF RULE FORM 
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EXAMPLE OF VALIDATION FORM 
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